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Information in this document is subject to change without notice. Companies, names and data 
used in examples are fictitious.     
 
1997 - 2005 by QA Software. All rights reserved.  No part of this document may be 
reproduced or transmitted in any form of by any means, electronic or mechanical, for any 
purpose, without the express permission of QA Software.  
 
Microsoft Windows, Microsoft Excel and Microsoft Visual FoxPr o are registered trademarks of 
Microsoft Corporation, HP and LaserJet are registered trademarks of Hewlett -Packard 
Company. Lotus and 1 -2-3 are registered trademarks of Lotus Development Corporation.  
 
Although QTRAK has undergone extensive testing, QA Soft ware makes no warranty or 
representation, either express or implied, with respect to this software or documentation, its 
quality, performance, merchantability, or fitness for purpose. As a result this software and 
documentation are licensed “as is”, and yo u, the licensee are assuming the entire risk as to its 
quality and performance. In no event will QA Software be liable for direct, indirect, special, 
incidental or consequential damages arising out of the use or inability to use the software or 
documentation. 
 
 
Please send your comments to  
 
 QA Software Pty Ltd  
 339 Queensberry Street,  
 North Melbourne, VIC 3051  
 Australia 
  
For technical support  
 
 Australia 
 Phone:  03 9326 8455  
 Fax:      03 9326 6544  
 
 International 
 Phone:  +61 3 9326 8455  
 Fax:      +61 3 9326 6544 
 
 Email: support@qa-software.com 
 Internet: http://www.qa -software.com  
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1.01 Introducing QTRAK 
 
QTRAK is a Correspondence Management  system for the management of proj ect 
information. Typical examples of the types of information QTRAK can be used to manage are:  
 
• Requests for Information.  
• Letters, faxes, and memorandums.  
• Site Instructions. 
• Advice Notices.  
• Non-conformance reports.  
• Variations/change orders.  
• Daily work reports. 
 
QTRAK is multi user and network compatible by design. It is ideally suited to be deployed 
over a Local Area Network.  
 
The main features of QTRAK are:  
 
• Generation, recording, and management of outgoing correspondence.  
• Sending of outgoing mail by Email , Fax or Hardcopy.  
• Recording and management of incoming correspondence.  
• Scanning of incoming correspondence if required.  
• Linking of related correspondence and documents.  
• Grouping together of related correspondence via electronic filing.  
• Management of actions arising from correspondence.  
• Document retrieval via search and find.  
 
 
1.02 Introducing Mail 
 
QTRAK uses the terminology “mail” to describe an item of correspondence that has a “ To” 
and a “From”. All mail in QTRAK is accessed through a single screen cal led the “Master 
Document Register ” even though all mail types are stored in separate database files.  
 
The are a number of components to any item of mail:  
 
• General fields such as Reference Number, Subject, and Date.  
 
• A Distribution , which defines who the co rrespondence is To, and any other distribution 

items such as Copies to. 
 
• Linked documents, which are used for generating cross -references between documents.  
 
• Attachments, which are used for attaching documents that have been created in other 

applications. 
 
• Binders, which are used for grouping related documents or electronic filing.  
 
• Actions, to define and delegate actions to be taken on correspondence.  
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1.03 Outgoing Correspondence 
 
QTRAK can be used to manage project correspondence both to external compan ies, and to 
other project team members within the same company.  
 
In most situations this will mean actually generating and sending correspondence items using 
QTRAK (ie. without creating a hard copy unless required). In other situations, where the 
correspondence has been created either via another computer application or using a 
handwritten form, the outgoing correspondence is simply registered in QTRAK. If the original 
documents are in electronic form (such as an Excel file) they can be attached to the ent ries in 
QTRAK. 
 
The transmission methods for sending outgoing correspondence range from printing 
hardcopies, to internal and external email, and automatic faxing assuming email and a 
modem are available.  
 
 

1.04 Incoming Correspondence 
 
Incoming Correspondence consists of emails, hardcopies, faxes etc.  
 
Incoming Correspondence received by traditional means is registered in QTRAK with as 
much of the detail of the item entered as required. If necessary, the incoming item can be 
scanned using the integrated scan ning functionality in QTRAK and the resulting image linked 
as an Attachment  to the QTRAK entry.  
 
With the eCorrespondence add on module, email from popular email clients can be imported 
directly into QTRAK.  
 
QTRAK also supports the use of a dedicated proje ct for pre-processing of incoming 
correspondence in situations where there are large numbers of smaller projects on a single 
installation. 
 
Regardless of which of the above methods are used, QTRAK facilitates simple generation of 
responses to incoming corr espondence and the ability to assign and manage actions arising 
from incoming items.  
 
 

1.05 Links and Electronic Filing 
 
Linking related correspondence enables powerful cross -referencing of documents.  
Documents can be Linked (cross-referenced) manually or automatically in QTRAK.  
 
In addition to cross referencing by the linking of related documents, QTRAK uses  “Binders” to 
provide an electronic filing system.  
 
Binders are ideal for grouping documents relating to particular issues, or for managing 
variations. A Binder might be created for “Issues” and Sections within this binder, created for 
each individual issue. All correspondence (incoming and outgoing) relating to a particular 
issue can then be filed in the relevant section within the “Issues Binder”.  
 
The use of binders in QTRAK enables tight control of the large amounts of correspondence 
generated on projects.  
 
Binders and Sections  simulate the way correspondence is filed using manual systems. For 
example, in a manual system, outgoing letters may be fi led in a lever arch file for outgoing 
letters and then copies taken for filing in a separate claims file. QTRAK documents can be 
allocated to as many binders/sections as required.  
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Note that while Binders and Sections provide a simple two level filing sy stem which is 
sufficient for most projects, QTRAK also includes a Multi Level  filing alternative. This allows 
an unlimited number of filing levels to be created, much like using Windows Explorer, 
although in QTRAK there is always only a single copy of any document, regardless of how 
many locations it may appear to be filed in.  
 
 

1.06 Actions 
 
Management of actions arising from incoming or internal correspondence and the expediting 
of responses to outgoing correspondence are a key feature of QTRAK.  
 
Incoming documents are entered in to the Master Document Register,  and actions assigned 
to one or more team members. When a user logs into QTRAK, the Task List on the Master 
Document Register will display all actions assigned to them with reference to the associate d 
documents. 
 
Administrators/managers can review all outstanding actions by responsibility. Users see only 
their own outstanding actions.  
 
For the expediting of responses to outgoing correspondence, QTRAK generates expediting 
reports for both outstanding  or overdue responses.  
 
 

1.07 Search and Find 
 
QTRAK is a fast, easy to use and a controlled method of creating and recording incoming and 
outgoing correspondence. However, retrieving or searching for documents at a later stage is 
also a key feature of QTRAK . There are a number of alternatives included with the program 
for this purpose. These are:  
 
Filtering: This is a structured search for say, “all correspondence received in the month of 
March from Joe Bloe that has the word Concrete in the Subject”.  
 
Intelli Search: This is a text search through the complete QTRAK System for 
correspondence containing a key word or string of words. All fields in the system are 
searched. 
 
Binders/Sections : The Binder view is a good way to find correspondence relating to a fil ing 
reference. 
 
 

1.08 How to get started with QTRAK 
 
QTRAK requires installation of some software. This can be obtained from www.qa-
software.com  or by contacting QA Software on:  
 
Phone:  +61 (2) 9326 8455 
Fax: +61 (2) 9326 6544 
Email:  sales@qa-software.com  
 
Use the Quick Start Instructions contained in Appendix A at the end of this document to 
Install the Software.  
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2.01 Login 
 
If QTRAK has already been installed on your Desktop but you are not at the Login screen, 
you need to start the program by clicking on the Start button, selecting P rograms, locating the 
work group QA Software, and selecting the QTRAK Correspondence Tracking System. You 
will then be presented with the Login Screen. Alternatively, if you have a short cut icon on 
your desktop for QTRAK, double click on this to start the  program. 
 
1. Enter the User ID as QA and press Tab. 
 
2. Enter the Password  as QA and press Tab. 
 
3. Select the Demonstration  project by double clicking on it, or just click on the OK button. 
 

You should now be looking at the QTRAK Dashboard .   
 

 
 

The above screen is the QTRAK Dashboard . At the top of the screen is the Main Menu.  
 
Displayed on the left are Favorites - some commonly used QTRAK menu items. These 
menu items are fully customisable for each user. During the tour you should use t he Main 
Menu options rather than the short cuts on the Favorties list to gain familiarisation with the 
menu system.  
 
Note that QTRAK is a project based  system. Every project has it’s own set of data files, 
just like having a separate filing cabinet per pro ject in the paper world. When logging into 
QTRAK the user selects the project they want to work with. Switching between projects is 
done from the File menu and sub menu Open Project. Storing QTRAK data this way 
provides for maximum flexibility. For example  the use of different forms and report 
formats per project.  

 



Chapter 2 – Guided Tour 

QTRAK Version 5 Guided Tour    Page 11   

2.02 The Master Document Register 
 
4. From the View menu at the top of the screen, select the Master Document Register . 

(Alternatively, use the Favorites and select the Master Document Register opt ion).  
 

The Master Document Register is the starting point for the majority of correspondence 
related actions in QTRAK.  

 

 
 

The Master Document Register  displays a list of ALL correspondence entries stored in 
the system. The large buttons (Tool buttons) at the top of the screen are used to create or 
edit correspondence items and to operate on the register when searching for 
correspondence items.  
 
The lower half of the screen shows a preview of the currently selected item of 
correspondence in the top half of the grid. The preview can be switched off by right 
clicking on any item on the top half of the grid and selecting Preview Pane  which will un-
select it. 
 
Notice that the correspondence items in the Master Document Register are sorte d 
(displayed) by default by first, the Type of document (in the above screen Architect 
Advices (AA) are displayed first), and then the reference number which is a unique 
identifier for each item.  

 
5. Try clicking on the column header for the column Reference to re-sort the order in which 

the mail entries are displayed. You should now see the items displayed by reference 
number regardless of correspondence type.  

 
6. To display only RFI’s, click on the large Show button and select Request for 

Information. You will  now be looking at a register of only RFI’s. This register could be 
printed by clicking the large Print button. To return to displaying all correspondence, 
select +ALL from the Show button options.  
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2.03 Creating a New Mail Item 
 
7. To create a new mail ite m, click on the large New Button from within the Master 

Document Register . You will be prompted to select from the available mail types.  
 

 
8. Select Request For Information  
 

Note that the list of available mail types in the demonstrat ion project is for evaluation 
purposes only. QTRAK is always configured for each client so that the mail types you can 
select from in your licensed version may well differ from those shown here.  

 
 

2.04 Adding the Distribution 
 
The Distribution is used to se lect the addressee or main recipient of the correspondence item 
(the “To”), and to set up any other distribution such as “Copies to”. The Select Addressee  
screen opens automatically when new items are created in QTRAK.  
 
9. At the Select Addressee screen shown  below, highlight Mr Frank Jacobs  (the Contact 

Name) on the left hand side of the window to select him. Contacts from a specific 
company can be displayed using the Company ID drop down selection if required and 
new Contacts can be added via the Edit Contact Details button. 
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10. Click on the right arrow button adjacent to the To box to make this contact the addressee. 

(Alternatively, double click on the selected contact. The first contact double clicked will be 
the To value for the RFI. Other contacts double clicked will default to the Copies to 
window). 

 
11. Select Mr Simon Campbell  from the left hand side of the window and this time use the 

Copies right arrow button adjacent to the Copies box to assign a copy of this RFI to this 
contact. 

 
Note that if you make a mistake in the above, contacts can be removed from the To and 
Copies windows by simply double clicking on them.  

 
12. Click on the OK button to return to the RFI form.  
 
 

2.05 Completing the Mail Header 
 

Back at the mail form your sc reen should look like the one below:  
 

 
The Mail Header (as shown above) contains information that is common to all QTRAK 
forms.  
 
The bottom two thirds of the screen are called the Mail Details  and contains information 
that is specific to each form type and hence will look different depending on what form 
type you are creating.  

10 
9 

11 

13 

14 

12 
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QTRAK supports multiple page frames for the Mail Details when large amounts of 
information needs to be captured. QTRAK also supports the use of a grid fo r the Mail 
Details section, for forms such as Variations where an unlimited amount of line items are 
required. 
 
Notice also that the Reference No (the reference number of the new RFI above) is blank 
at this stage. A reference number will be automatically g enerated when the RFI is saved. 
Automatic referencing of correspondence in QTRAK is a key benefit to clients and a 
number of sophisticated numbering system alternatives can be supplied if required.  

 
Fill in the remainder of the Mail Header details as foll ows: 

 
13. In the Subject box, enter the subject as Request for Information on Concrete. This is 

effectively the title of the mail item.  
 
14. Enter the Respond by date as four days after the Dated date. This is the date by which 

you require a response to the RFI.  You can use the date picker button to simply select 
the date rather than typing it if you prefer.  

 
Note that you can quickly check for overdue responses from the Master Document 
Register by clicking on the Hot List button – try this when you have returned to the Master 
Document register.  

 
15. Set the Status to Outstanding by clicking on the appropriate radio button (This is the 

default). 
 

The Mail Header section of the RFI should now look as follows:  
 

 
16. Save the document by clicking t he Save tool button. The next sequential reference 

number will be allocated to this RFI.  
 

Note that the FROM value defaulted automatically based on your USER ID when you 
logged into QTRAK. This rule can be modified if required via Tools \Mail Type Rules. 

 
 

2.06 Filling in the Details 
 

 
 

17. The detailed text or message is entered in the Details window in the lower half of the 
screen under Details.  

15 
16 18 
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The remaining fields on the lower half of the screen are examples only. See Chapter 3 for 
more examples of Mail Details for various mail types.  
 
Note also that QTRAK has an in built spell checking facility that can be run from the main 
menu when in a mail form.  

 
 
2.07 Adding Links 
 
Links can be used to build a permanent “cross -reference” between one or more pieces of 
correspondence.  For example, to relate an incoming item to an outgoing item. A document 
can have multiple links.  
 
18. You can now cross-reference this RFI by clicking on the Edit Links button to the right of 

the Links drop down list in the top right corner of the screen.  
 

The following screen will be displayed:  
 

 
19. Select AA 000012 from the left hand window (that lists all Documents).  
 
20. Either double click on it or use the right arrow button to add it into the  Linked Documents  

window. (Use the left arrow or double click to remove a selected item if required).  
 
21. Click on the OK button to save the links and return to the RFI.  
 

You will notice back at the RFI screen that there is now a link to this RFI.  
 
22. You can move to the linked document by clicking on the Show Linked Data  button to the 

far right of the Links drop down list. This will take you to the details of AA -0012.  
 
23. Click the Close button to return to the RFI if you experiment with this.  
 

19 20 

21 
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2.08 Filing via Binders 
 
QTRAK supports two methods of electronic filing. Binders and Sections are the default 
method and provide a simple yet extremely popular method of filing. The alternative to 
Binders and Sections is the use of a Multi Level filing system. This is ou tside the scope of this 
Guided Tour. 
 

 
 
24. Click on the Edit Binders button adjacent to the Binders drop down list, to file this RFI in 

a Binder. 
 

This opens the Binders and Sections  screen. 
 

 
25. Click on the drop down list next to the word Binder and select the Binder as Client from 

the list. 
 
26. You should now see a list of Sections that relate to the Binder Client. Double click on 

Correspondence to file this document in the Client Binder and Correspondence  Section.  
 
27. Click OK to save your selections.  
 

Note that any item of correspondence can be “filed” in as many Binder/Section 
combinations as required.  

 

24 

25 

26 

27 
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2.09 Printing and Sending the RFI 
 
QTRAK can be used to send the RFI electronically either by email or fax to the nominated 
distribution. Alternatively the RFI can be printed out and sent by traditional means.  
 
28. A printed copy of the RFI can be generated by using the Preview (or Print) button. Click 

the Preview button to Preview the RFI.  
 

Note that the format of the RFI report is an example only. As mentioned previously in this 
Guided Tour, QA Software customise the form types and report formats for each client so 
that documentation coming out of QTRAK appears as per your company’s existing 
documentation generated by other means.  

 
 
 
 
 

 
29. Click on the Close Preview  button on the Print Preview tool bar to return to the RFI 

screen. 
 
The RFI can now be “Sent”. There are two options:  

 
• If the RFI is going to be sent as a Hardcopy, then print it and then click the Freeze 

button to the right of the Toolbar. This will make the key data in the RFI read only, 
preventing further changes to all but certain fields. This is useful to prevent other 
users inadvertently changing data after it has been “sent”.  

 
• If on the other hand the RFI is going to be emailed, simply click the Email report 

button on the toolbar and then click Send at the next screen. This action will also 
freeze the mail item.  

 
Note that when a mail item is “Sent”, the Date Sent and Time Sent fields in the Mas ter 
Document Register are updated.  

 
30. To return to the Master Document Register and save your work, click on the Close 

button. The document will be saved automatically.  
 
 

2.10 The Address Book 
 
In sections 2.03 to 2.09 above you have created your first ite m of QTRAK Correspondence.  
The next step is to add a new contact into the QTRAK Address Book.  
 
31. From the Master Document Register Toolbar, click the Contacts button. 
 

The Address Book details will be displayed.  
 

2
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The Address book is structured in two levels: Companies; and Contacts within 
companies. To add a new contact within a new company, the company itself must first be 
created. 
 

32. Click the Edit Company Details  button. 
 

 
33. Click the Create a New Company button. 
 

 
 
 

32 

33 

34 

38 
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34. Enter the Company ID as MC. 
 
35. Enter the Title of the Company as My Company. 
 
36. Select the Company type as SUB – Subcontractor  
 
37. Click the Add button. 
 
38. Click the Close button at the Company Details screen.  
 

You are now ready to add the first Contact within the company My Company. 
 

39. Click the Create a New Contact button. 
 

 
40. Enter the contact ID as TS, and the First and Last Name as Tony and Simpson 

respectively. 
 
41. Click the Add button. 
 
42. Complete the address details in the right hand side of the contact details screen.  
 

 
 

43. Click the Close button when done.  
 
 
 

39 
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2.11 Create another Mail item. 
 
To show the flexibility of the QTRAK mail screens, try creating a new Non Conformanc e, 
addressed to the company and contact created in section 2.10 above.  
 
44. Click the New button at the Master Document Register . 
 
45. Select Non Conformance  as the Mail Type. 
 
46. At the Select Addressee  screen, select Tony Simpson as the TO person. Select Joe 

Fredricks as a CC value, and click OK. 
 
47. Enter a Subject value. 
  

 
Notice in the above screen that the lower half of the screen has a number of fields and 
option buttons. These mail details screen can be designed to suit any customer 
requirements. 

 
48. Click the Down arrow button on the far right of the above screen to see additional page 

frames of information in relation to this Non Conformance.  
 

 
 

48 
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49. Click the Down arrow button again to get to a third page frame.  
 

 
50. Click the Save button on the toolbar and perhaps print a copy of the Non Conformance.  
 
51. Click the Close button on the toolbar when done to return to the Master Document 

Register. 
 
 

2.12 Applying a Filter 
 
The remainder of the Guid ed Tour is devoted to document retrieval or search and find. The 
first method that you will use below is a Filter. Filters can be applied throughout QTRAK when 
viewing the Master Register of documents, printing reports etc.  
 
You are now going to search for  items of correspondence that are dated somewhere in March 
2002 and are to do with the subject “Contamination”.  
 
52. In the Master Document Register, click the large Filter button to open the Build Filter 

Expression screen. 
 

Select the field criteria as shown  below.  
 
53. On Row 1 of the filter, click the drop down list under Field Name and select Subject (the 

Subject is a field on all QTRAK correspondence).  
 
54. Press Tab and in the Comparison field type “c” for contains or select contains from the 

drop down list (you may need to scroll to find this).  
 
55. Press Tab and type “Contam” in the value box (short for contaminated).  
 

 

59 
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56. Now go to the next row and type “d” for dated or select this field from the list.  
 
57. Press Tab and type “g” for  greater than and press Tab and enter 28/02/0 2.  
 
58. On the third row setup “Dated less than 01/04/0 2.” 
 
59. Click OK to activate the Filter.  
 

Back at the Master Document Register, the Filter button label will have a red background 
indicating that you are viewing  a filtered selection. Note that there are a number of items 
of correspondence listed of varying mail types.  
 

 
60. To see just Requests for Information that meet the filter criteria, click the Show button 

and select Request for Information. 
 
 

61. Double click on the item RFI 000017 to open up the details of this RFI. Click on the Close 
button at the RFI screen to return to the above view.  

 
62. Click on the Show button and select +ALL to see all mail types again that meet the filter 

condition set above.  
 
63. Click the large Print button to generate a printout of this filtered section.  
 
 
 
64. Click the Close Preview  on the Print Preview Toolbar to exit the preview screen.  
 
65. To clear the filter, click on the Filtered button again and click the Clear button on the 

Build filter expression window. Click OK to return to the Master Document Register.  
 
Note that the Filter, Show, and Hot List buttons all work in conjunction with one another. 
For example to see all Outstanding Faxes with the word concrete i n them, you would set 
up the filter for Subject contains concrete, and then click the Show button and select 
Faxes and then click the Hot List button and select Outstanding.  
 
 

2.13 View Binders 
 
If you know where the correspondence you are looking for shou ld be filed, then an alternative 
way of finding it is to view the contents of the appropriate Binder/Section.  
 
66. Click the large View button on the Master Document Register and from the menu list that 

appears, select Binders - Tree View . 
 
 

60 
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67. Clicking the +/- boxes expands/contracts the selection. Click the + next to Client to 

expand this Binder.  
 
68. Then click on the Section Correspondence  and you will see your RFI neatly filed. Double 

click on RFI 000025 to open it.   
 
69. Click Close at the RFI Edit Mail screen to return to the screen above.  
 
70. Click the Close button to exit and return to the Master Document Register.  
 
 

2.14 IntelliSearch 
 
The IntelliSearch in QTRAK is a text search similar to the operation of a Internet style search 
engine. QTRAK will search for one or more words throughout all fields in one or more projects 
to find Correspondence that meet the search criteria. Including File attachments in the search 
process is optional.  
 
71. Click the large Search button on the Master Do cument Register.  
 
 
72. Enter conc as the search criteria as shown below:  
 

 
 
73. Click the Search button. 
 

67 

68 
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74. Click the OK button on the search results window.  
 

All documents in the current project having conc anywhere within them will be li sted. Any 
of the documents can be opened by double clicking on them.  
 

 
 
75. Click the Close button to return to the Master Document Register.  
 
 

2.15 Using the Hot List 
 
The Hot List in QTRAK is used to provide a quick view of all out standing correspondence, all 
responses overdue or outstanding, or to view correspondence based on an alternative status 
such as Pending.  
 
76. Click the large Hot List button on the Master Document Register. Select Outstanding 

from the options. You will notice  that only correspondence items that are red are 
displayed. 

 
77. To understand why these items are all outstanding, double click on any item and note the 

status setting. It will be outstanding. If you change this setting to Closed Out  for example 
and close the item, then this piece of correspondence will be removed from this Hot List 
display. 
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2.16 Other things to try 
 
You have now completed the basic QTRAK Guided Tour. If you would like to explore other 
features of QTRAK, try the following:  
 
Standard Reports 
 
78. From the File menu, select Print - Standard reports  (you will need to close the Master 

Document register if it is open using the large Close button on the Toolbar).  
 
79. Double click on report 02 – By Type and Document Number - including Links . You 

should get a screen preview that looks like the one below. Notice this is a register of all 
correspondence with cross -references (links) printed as indents but in full.  

 

 
80. Close the preview and click the Cancel button to return to the Main Menu.  
 
Other Views 
 
81. Return to the Master Document Register using the View menu and sub menu Master 

Document Register. Click the large View button on the MDR toolbar and select the 
Distribution View . This is a very useful view of the Master Register to wor k with 
correspondence based on the To, Copies To, and From values. Simple select a company 
and you will see only correspondence in which the selected company is either the To, 
From or CC value.  

 
Mail Type Rules 
 
82. It is possible in QTRAK to define basic rule s for each correspondence type provided. To 

investigate this, use the Tools menu and sub menu Mail Type Rules.  
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Mail Statistics 
 
83. At the Dashboard, key mail statistics are displayed for both Incoming and Outgoing Mail 

for: 
 

• Mail with status outstanding . 
• Mail with responses outstanding or overdue. 
 
Click any of these options to be taken to a filtered view of the Master Document Register 
displaying on the relevant mail items.  
 

Export Data 
 
84. Data in QTRAK can be exported to MS Excel and other formats using the Wizar ds\Export 

Data option. 
 
 

2.17 Where to now? 
 
85. To exit QTRAK, use the File menu and sub menu Exit option. 
 
86. If you are interested in purchasing QTRAK, the next step is to request a quotation from 

QA Software. Have ready the number of mail types that you want to incorporate into 
QTRAK (it is not necessary to have all of them at the beginning as mail types can be 
added at any time).  

 
87. See also Chapter 3 which has some examples of configured versions of QTRAK.  
 

Listed on the following page is a summary of Issues, Features, and Benefits in relation to 
the QTRAK System.  
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QTRAK – Features and Benefits  
 

ISSUE FEATURE BENEFIT 
Your company needs to maintain 
a register of incoming project 
correspondence.  
 

A simple incoming correspondence 
register enables items to be 
registered, cross referenced, and 
filed for easy action and retrieval.  
 

All incoming correspondence is 
easily accessible. If scanning is 
deployed, incoming items can be 
viewed without using the 
hardcopy. 

Your company needs to manage 
the generation of outgoin g 
correspondence.  
 

QTRAK includes all your 
correspondence types. It is a 
custom fit solution  with all items 
generated in the same way.  
 

Containing only the form types 
you use, generating outgoing 
correspondence with QTRAK is 
simple, fast and saves time an d 
$$. 

Your company needs a better 
way of managing the reference 
numbering of outgoing 
correspondence.  

Automatic referencing  of all 
correspondence in QTRAK is a key 
feature. A variety of configurations 
are available.  
 

Auto reference numbering saves 
time and reduces errors. When 
complex numbering is required, 
the benefits are even greater.  

Your company needs a system 
for managing Site Instructions, 
Requests for information, and 
other project forms.  

QTRAK correspondence types are 
developed for each client ba sed on 
their existing templates, from Site 
Instructions to Non Conformances.  
 

The custom fit QTRAK concept 
means minimal change 
management issues, and ready 
acceptance by users.   

Your company needs to better 
manage the filing of 
correspondence so that 
information is easier to find.  

Binders and Sections  in QTRAK 
provide a simple means of 
electronic filing.  

Being able to file a document in 
multiple locations while retaining 
only a single copy of the 
document, improves search and 
retrieval.  
 

Your company needs to be able 
to better cross reference related 
documents.  
 

Links are a means of relating one 
or more documents to the current 
document. A permanent thread is 
created between the items.  
 

Linking enables the following of 
correspondence trails, months 
after an event took place.  

Your company needs to get 
better control of managing 
outstanding responses to 
correspondence.  
 

The QTRAK Hot List  enables 
outstanding correspondence, 
regardless of type to be viewed 
with a single click.  

Managing responses reduces t he 
delays caused by waiting for 
answers. The Hot list provides 
managers with the tools they 
need. 
 

Your company needs a method 
of managing internal actions 
arising from correspondence.  
 

Multiple Actions can be assigned 
to all correspondence (in and out). 
Assigned actions appear in the 
Task List for each user.  

Improved response times to 
issues requiring action by 
internal staff. Keep an audit trail 
of who had to do what, and when 
they did it.  
 

Your company needs to be able 
to send correspondence 
electronically, but in a more 
controlled way than simple email 
messages.  

All outgoing correspondence types 
in QTRAK, including instructions 
and RFI’s, can be sent directly 
from QTRAK via email . 

Electronic correspondence is 
stored in a central location, 
visible by al l (with security). Mail 
is sent fast but is still controlled 
(and referenced).  
 

Your company needs a simple 
system for correspondence 
management that is easy to use, 
and requires minimal training.  

The Master Document Register  
displays all correspondence t ypes 
in a single screen. Training times 
are typically 15 minutes per user.  

QTRAK is simple to use so 
people do use it. This ensures 
that all correspondence will be 
captured.  
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Appendix A – Quick Start Instructions for Installing QTRAK 
 
This set of instructions is provided to enable those familiar with installing software to get up 
and running with QTRAK fast. These Quick Start instructions  contain the key steps to 
installing and setting up QTRAK. 
 
A.1 System Requirements 
 
The system requirements for running QTRAK are: 
 
Hardware/Software Minimum 

Requirements 
Recommended 
Requirements  

Computer/Processor Pentium 250 
 

Pentium 800 

Memory (RAM) 64 MB 
 

128 MB 

Available Hard Disk Space  30 MB 80 MB 

Display 800 x 600 16 Bit  
 

1024 x 768 16 Bit  

Operating System Windows 98, Windows Me, 
Windows 2000, Windows 
NT, Windows XP 
 

Windows 98 

 
 
A.2 Software Installation  
 
A.2.1 The Windows Installer 
 
The Installation of QTRAK requires the Windows Installer .  
 
If you are running Windows NT 4.0 or Windows 9 8, you must first update your Windows 
Installer to version 1.1 before installing QTRAK. Contact QA Software to obtain details of how 
to get the latest Windows Installer.  
 
If you are running Windows 2000, you already have this installer and there is no need to 
reinstall this tool.  
 
You are now ready to install the QTRAK application.  
 
A.2.2 Installing the QTRAK Application 
 
1. Insert the QA Software CD and if it auto loads, simply click the Install QTRAK option at 

the QA Software menu and follow the installation ins tructions. QTRAK will be installed in 
C:\Qasoft\Qtrak\ by default.  

2. A short cut icon on your desktop will have been created to access 
C:\Qasoft\Qtrak\Qtrak.exe 

 
If the CD does not auto load:  
 
3. Using Windows Explorer locate the D: \Qtrak\Setup folder and double cli ck on QTRAK.msi 
4. Follow the install instructions as above.  
 
If you downloaded QTRAK from the Internet: 
 
5. Using Windows Explorer double click on the QTRAK.msi file you downloaded.  
6. Follow the install instructions as above.  
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A.3 Configure your work station 
 
1. If your monitor is not already set to a display of 800 x 600 pixels, you should change it to 

this setting before proceeding. To do this, right click on any blank space on your desktop, 
select Properties and then the Settings tab. Adjust the screen resolution to 8 00 x 600 
pixels. 

 
2. Create a shortcut icon on your desktop (if one was not automatically created during 

installation) to access the QTRAK.EXE  (Located by default in the folder C: \Qasoft\Qtrak\) 
 
 
A.4 Running the QTRAK System 
 
7. Double click the QTRAK icon on your  desktop. (Or use Start | Programs | QA Software | 

QTRAK).  
8. At the login screen, the User ID = QA and the password is also QA.  
9. Select the Demonstration project by double clicking on the Project Name and you will be 

located at the Dashboard. This is the starting point for all QTRAK actions. 
 
 
A.5 Support 
 
If you are having any problems with getting our software installed or getting started, please 
don't hesitate to contact our Technical Support Divi sion by Phone: +61 (3) 9326 8455, Fax: 
+61 (3) 9326 6544, Email: support@qa-software.com  
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Appendix B - Sample Mail Types 
 
The flexibility of QTRAK in being able to be Custom fit to a customers requirements is a key 
feature of the system. On the following pages are some sample screen shots from a variety of 
custom mail types developed for custome rs. 
 
A typical list of correspondence types: 
 

 
 
Sample Minutes of Meeting form:  
 

 
 
Note in the above example, Meeting items are auto numbered and each minute can be 
managed in terms of actions and status.  
 
Also it is possible to copy Open items from one  meeting to another.  
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Sample multi page frame Site Instruction form: 
 
Page 1 
 

 
 
Page 2 
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Sample multi page Non Conformance: 
 
Page 1 
 

 
 
 
Page 2 
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Sample multi page Daily Site Report: 
 
Page 1 
 

 
 
Page 2 
 

 
 
Page 3 
 

 
 
 


